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1 MyUniverse 

1 Introduction  

1.1 Integrate  your Information  
MyUniverse is an application you can use to take information from various parts of your life and bring 

them together into one place in a new visual and dynamic way. 

The MyUniverse product is a building block application with each building block representing a piece of 

information or knowledge, or performing a specific kind of function. MyUniverse building blocks allow 

you to structure the information visually in a creative way that makes sense to you.  

The different types of building blocks, called Smart Parts, each have specific capabilities. The capabilities 

range from document, media and Internet links, to information processing, to creating events in the 

application. 

 

1.2 Visual Information Management  
MyUniverse helps manage your information in a visual way. MyUniverse shares some functionality with 

graphics programs by giving you control over visual properties of Smart Parts such as color and shape, 

providing the ability to store, maintain and present information in a visually appealing way. 

 

1.3 Smart Parts  
aȅ¦ƴƛǾŜǊǎŜΩǎ ŦƭŜȄƛōƛƭƛǘȅ ƛǎ ƛƴ ƛǘǎ Smart Parts. Each Smart Part performs a specific function much like a 

building block. However, instead of building a house, a bridge, a castle, a car or whatever you can 

imagine, you can build a home inventory, an outline for a new book, an organizational chart, a net worth 

calculator, or whatever you can imagine. 

 

1.4 What can you do with MyUniverse ? 
MyUniverse is designed to be flexible. Instead of forcing you into doing things in a specific way, 

MyUniverse gives you flexibility to do things the way you want to. With this flexibility, you can find many 

ways to use MyUniverse for wide ranging situations both at home and at work. 

The strength of MyUniverse is that in one application you can do many things and because of its building 

block design, its ability can grow as additional Smart Parts are developed. 

Because MyUniverse and its Smart Parts are all about information, it can work with information directly 

entered into the application, from the Internet, and from databases and files, as well as communicate 

with you over the Internet, through e-mail and even over Twitter. 
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1.5 Getting Help  
There are a number of ways to get help with using MyUniverse. 

¶ This User Manual 

¶ The Smart Part Reference Manual 

¶ Application Help 

¶ Online Tips 

¶ The Support Page at www.gotmyuniverse.com 

 

1.6 Editions  
MyUniverse is available in three editions: 

Viewer Edition 

The Viewer Edition is a freely licensed edition that is made available to the public. This edition will allow 

users to open and view projects, but not edit them. The Viewer Edition contains all the Smart Parts, 

allowing for published projects to be viewed without needing to acquire the Personal Edition, 

Professional Edition or Smart Parts. 

Personal Edition 

The Personal Edition is a freely licensed edition for use at home, school or work. There is no license 

expiry, no limitation to project size or parts usage, and no nag screens or popups. 

Professional Edition 

The Professional Edition is a licensed edition that adds features on top of what is provided with the 

Personal Edition which provides ways to create much more dynamic projects. In some cases, Smart Parts 

will provide additional capabilities in the Professional Edition that are not available in the Personal 

Edition. 

Smart Parts 

MyUniverse includes a basic set of Smart Parts but additional parts can be acquired. Some parts are 

freely available to the public and others require the purchase of a license. 

This User Manual covers the Personal and Professional editions. Professional Edition specific features 

will be identified. 

http://www.gotmyuniverse.com/
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2 Glossary 
 

Terminology used in this document and MyUniverse is explained here. 

Access (to) 
To get access to a information referenced by the part (normally by double-
clicking, single-clicking or hovering) 

Details Panel 
This is the tab on the right that is used by parts to show information specific 
to the part 

File Extension The part of the file name after the period 

Hover Moving the mouse over a part without clicking on it 

Link Reference a piece of information 

Media A Movie, Music or sound clip 

Project 
What we call a project is what other applications will call a document. One 
project is stored in one file. 

Smart Part 
A building block part which has different functionality depending on the type 
of part. 

Store To store information inside a project file rather than linking to it 
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3 Best Practices 
To give you a better experience using MyUniverse, we have assembled some recommended practices as 

guidelines you can follow.  

Structure projects to go deep, not wide 

What does this mean? MyUniverse projects are meant to be structured by organizing information 

over multiple pages keep related information together. Going wide means putting everything on 

one page which makes it more difficult to keep things organized. You can do this but putting 

hundreds of parts on a single page can affect performance when making edits. The key to 

stǊǳŎǘǳǊƛƴƎ ǇǊƻƧŜŎǘǎ ƛǎ ǘƻ ƳŀƪŜ ǳǎŜ ƻŦ ΨPageΩ ǇŀǊǘǎΦ 9ŀŎƘ Page part adds another page for you to work 

with. Because you can put Page parts inside pages, you can really organize information with multiple 

levels. 

Use timer settings sensibly 

Refreshing internet resources excessively can be taxing on the application, the network and servers. 

Does it really make sense to update a bunch of stock quotes every second? Note that in some cases 

excessive refreshing can result in being blocked by the web site. 

Save often and protect your files 

As with all software applications, it is always good practice to protect your investment in building a 

project by taking the necessary steps to ensure you do not lose information. MyUniverse includes 

Auto Save and Backup features that can help τ but this is not enough. It is a good idea to regularly 

keep copies of the project files on a separate backup device and even at a different physical location 

for important documents. 

Protect projects with a password if they contain sensitive information 

MyUniverse gives you the ability to safely protect sensitive with password protection. By giving a 

project a password, the information in the project is encrypted so it will not be possible for anyone 

else to be able to get to that information. Keep your password confidential and secure. If you lose or 

forget the password, it cannot be recovered so it will not be possible to open the project. 
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4 Getting Started with MyUniverse  

4.1 Intro duction  
MyUniverse is an application that grows with your knowledge of it. The existing range of Smart Parts can 

be a little overwhelming for some so, we recommend that you start with the basic Smart Parts and add 

parts to your repertoire as you become more comfortable. 

 

4.2 Installation  
MyUniverse is built on Microsoft .NET technology. The current application is built on .NET 3.5 Service 

Pack 1 meaning this is a requirement for MyUniverse to run. The Setup program for MyUniverse will 

check whether .NET 3.5 SP1 is installed on your computer. If it is not present, you will be asked to 

install .NET 3.5 SP1. 

For additional information including a walkthrough, refer to the Installing MyUniverse document.    

 

4.3 Online  Tips  
When MyUniverse starts and if the Internet is accessible, MyUniverse will do a check for Online Tips 

from our website. Online tips can be a valuable source of information allowing us the opportunity to 

provide up-to-date tips and ideas on how to make the best use of MyUniverse as well as providing any 

other valuable information such as software updates, new samples or announcements. Tips may also 

contain links to web pages or downloads. 

 

If you have read a tip and no longer want to see it again, click the remove button at the top/right corner 

of the tip. This removes the tip and ensures you will not see it again in the future. The refresh button at 

the top will request an update of the tips if there are more tips available.  

If you do not wish to receive Online Tips when MyUniverse starts, they can be turned off by un-checking 

the Show Online Tips on Startup checkbox in Application Options. In Applications Options, there is also 
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a Reset Tips button which will allow you to see all tips including those which were previously removed 

from the Online Tip panel. 

At anytime, you can view the tips by clicking Show Online Tips in the View menu. 

 

4.4 Working with Files  
Creating a new project 

At any time, if you wish to create a new project, select the New item from the File menu or press the 

New button  on the toolbar. If there are any changes in the current project, you will be asked if you 

want to save before continuing. 

Opening a project 

At any time, if you wish to open another existing project, select the Open item from the File menu or 

press the Open button  on the toolbar. If there are any changes in the current project, you are asked 

if you want to save before continuing. 

A standard open dialog allows you to browse the directories for the project file you want to open. Once 

you have located it, select the file and press the OK button to open the project. 

Alternatively, an existing project can be open if it was a recently opened file. This is done by selecting 

Open Recent from the File menu. This will show a list of the eight most recent projects that were open. 

Selecting one of them will load the project file. 

Saving projects 

Projects can be saved at any time by selecting Save from the File menu or by click the Save button  on 

the toolbar. This will immediately save the project file. 

Save As 

If you would like to save the file with a different name, select Save As from the File menu. This will open 

a file dialog which you can use to specify where the new file will be saved to. Select the directory, give 

the file the new name and click OK. 

 

 

4.5 The Main Window  
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As is normal for Windows applications, the menu is at the top of the screen. Below the menu is toolbar. 

At the bottom is a status section which shows any messages the application reports. 

The main sections of the application are the three panels going across from left to right. 

The left panel contains several tabs the most important of which is the Smart Parts tab. This is the 

library of parts that are available for use in projects. 

The middle is the Project Page which is the main working area. Open pages in the main work area are 

contained in tabs just above the page. Switch between open pages by selecting the page tab at the top. 

Just above the tabs is a Project Path bar which is a navigation aid to help you recall where in a structured 

project you are. 

The right panel contains additional tabs which are primarily used for information display. The Details tab 

on this panel shows information specific to the part selected. 

At the bottom, just above the status section, is the Smart Part Property bar. Whenever a part in the 

project is selected, this bar shows a set of Property buttons specific to that part. Clicking on one of the 

property buttons opens a property panel showing a related set of configurable properties. 

 

4.6 Menus and Toolbar  
As with normal Windows applications, menus and toolbars are available for any application action you 

wish to perform. This section provides a brief introduction to what the menus and buttons do. 

Menu 
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New ς Create a new project 

Open ς Open an Existing project 

Open Recent ς Open one of the eight most recently opened projects 

Save ς Save the project 

Save As ς Save the project under a new filename 

Close All Tabs ς Closes all Pages except for the Main one 

Clean ς Makes the project file as small as possible 

Publish ς Makes a .MUPub view-only project file 

Save Image ς Saves the current project view to an image file 

Import ς Imports a set of parts stored in a .MUSel file 

Export ς Exports the selected set of parts to a .MUSel file 

Page Setup ς Set configuration settings to be used when printing 

Print Preview ς Preview what prints will look like 

Print ς Prints the current page to a printer 

Exit ς Closes an Application 

 

 

Undo ς Undoes the last project change 

Redo ς Redoes the last undo 

Cut ς Cut the selected parts to the clipboard 

Copy ς Copy the selected parts to the clipboard 

Paste ς Paste the parts in the clipboard to the current project page 

Delete ς Delete the selected parts 

Select All ς Select all the parts in the current page 

Group ς Group the select parts 

Ungroup ς Break up the selected group 

 

 

Zoom 100% ς Zoom the current page to 100% 

Zoom Extents ς Zoom the current page to show all parts 

Full Screen ς Switch to and from Full Screen 

Flip ς Swaps the size of the Project Page and the Right Panel 

Project Path ς Shows or hides the Project Path bar 

Smart Part Box ς Choose different ways to view parts in the Part Box 

Reset to Default View Settings ς Puts all the panel sizes to a default view 

Layers ς Show the Layers panel in the Details tab 

Slides ς Show the Slides panel in the Details tab 

 

 

Application Options ς Configure application level options 

Project Options ς Configure project level options 

Current Background Page ς Change background settings on the current page 
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Skins ς Select a different application skin (See 4.11). 

 

 

 

 

Project Summary ς Show a summary of all parts used in the project 

 

 

Help ς Open the help file 

Licenses ς Add and show licenses 

Support ς Go to the MyUniverse support web page 

About ς Information about MyUniverse 

 

Toolbar 

 

 

 Create New, Open or Save a Project 

  Print and Print Preview 

   Property Painter 

 Cut, Copy, Paste or Delete parts 

  Undo or Redo changes 

  Zoom in or out 

 Navigate back, forward or up 

   Set Application Online or Offline 
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   Flip to swap the size of the Project Page and the Right Panel 

   Switch back and forth between full screen 

  Group and Ungroup parts 

   Notify parts to refresh their information 

   Show the Layers panel in the Details tab 

   Set to Mind Map mode when down 

   Show the Slides panel in the Details tab 

Note that some parts may add additional menu items or toolbar buttons. 

 

4.7 Panning and Zooming  
Each page in a MyUniverse project can be considered a drawing sheet. There are several ways of 

changing the view of a page or zooming in and out. 

Panning 

Panning is the ability to shift the view of a page left, right, up or down without changing the zoom. 

On the bottom right of the main project page area are scroll bars. Changing the scroll position on the 

bottom shifts the view to the left and right. Changing the scroll position on the right scroll bar shifts the 

view up and down. 

If you have a three button mouse the middle button (or the scroll wheel button if you have a scrollable 

mouse) can make it much easier to pan around a page. With the mouse cursor over the main page area, 

press and hold the middle mouse button down while moving the mouse left/right or up/down to pan 

the page. 

Zooming 

Just to the right of the bottom scroll bar is a zoom bar. By Changing the zoom bar position, the page will 

be zoomed in and out around the center point of the page. The zoom bar will always update to the show 

what the page is currently zoomed at. 
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Additionally, the toolbar provides two buttons that can also be used to zoom in and out around the 

center of the page. 

Also, in the View menu are two items that can help with zooming. Zoom 100% will change the zoom of 

the current page back to the standard zoom of 100%. Zoom Extents will change the page zoom to a 

percentage where all parts will be visible. 

If you have a scroll mouse, scrolling the mouse wheel up and down will zoom the page in and out 

around to point where the mouse is over. 

Scroll Mouse 

A scroll mouse is highly recommended for use with MyUniverse. Once you are familiar with how to use 

the mouse wheel button with MyUniverse, you will find it to be the fastest way to pan and zoom around 

a project. 

4.8 The Status Bar 
The status bar is used by MyUniverse to show messages. Most commonly, it is used indicate what is 

happening during saving and publishing. At the right end of the status bar is a progress bar which is an 

indicator showing how the opening or saving is progressing. 

 

 

4.9 Undo/Redo  
At times, you may find that you have made some changes to a project that you would like to undo. 

MyUniverse remembers up to the last 100 changes that were made to a project. This means you can 

ǳƴŘƻ ǳǇ ǘƻ ǘƘŜ ƭŀǎǘ млл ŎƘŀƴƎŜǎΦ LŦ ȅƻǳ ŘŜŎƛŘŜ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ǘƻ Řƻ ǘƘŜ ǳƴŘƻ ǎǘŜǇΣ ȅƻǳ Ŏŀƴ ǳǎŜ ǊŜŘƻΦ 

Note that if you do an undo and then make another project change, you will not be able to redo. 

  

It is important to understand that undo is not absolute for everything. It is mainly for project or part 

property changes. In some cases, such as editing text in a note partΩǎ ǘŜȄǘ ŜŘƛǘƻǊ, this is not a part of the 

application undo. In this case the note partΩǎ ŜŘƛǘƻǊ, it has its own Undo and Redo capability. 

Performing an undo or redo is done by clicking the toolbar button. 

Clicking the down arrow beside the buttons will show a list of the steps that can be undone. This makes 

it easy to undo multiple steps at one time. While the list is open, dragging the mouse down the list will 

highlight all the items to be undone. Clicking will perform all the highlighted undo steps. 
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4.10 Flip  
When accessing information in a project most of your interactions will be between the middle and right 

panels. For example, accessing a link part that is linked to a web page will switch the right panel to the 

show the Web Browser and will browse to that link. 

Because there is a limitation to what can be shown on a screen, there will be times when you want the 

middle panel to be bigger and other times you want the right panel to be bigger. 

To make it easier to switch sizes between having the middle panel wider, the right panel wider, the main 

panel full size or the right panel full size, a Flip button  is available on the toolbar. Flipping will switch 

between four different views. 

A flip is depicted below. 

    

The flip keyboard shortcut is F12. 

 

4.11 Skins 
Skins customize the look of the MyUniverse application. To change a skin, click on the Presentation 

menu and select Skins. At this time, there are five skins available: 

¶ Windows Default ς Determined by Windows 

¶ Baby Blue 

¶ Baby Blue Large 

¶ Midnight 

¶ Midnight Large 

The Baby Blue Large and Midnight Large skins will make all text, menus and dialog boxes larger and 

easier to read.  

Here are two sample skins: 
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4.12 Search 
MyUniverse provides a search capability through the Search tab on the left panel. There is a text box to 

enter your search text. 

There are options that allow you to do a search that can be case 

sensitive  or that will match the whole word . 

Additionally there is an option that allows you to select the range of 

the search, whether it will be just the current page or will include all 

pages and whether the search will be a quick search or full search 

that will look deeper into the part, for example, the text in a note 

part. 

 

4.13 Bookmarks  (Professional Edition Feature ) 
Bookmarks provide a way to Tag a part to make it easier to find.  

The search tab on the left panel contains a tab which shows all bookmarked parts. 

To bookmark a part, select the part, click the right mouse button and select Bookmark from the popup 

menu. This will open a popup box giving a suggestion for what to name the bookmark. You may alter the 

suggestions or just click OK to create it. This will add a Bookmark icon to the part and will add an entry 

to the bookmark panel on the search tab. 

At anytime, you can return to the bookmarked part by double clicking on the bookmark item in the 

bookmark panel. This will make the part visible and select it no matter where in the project the part is. 

In the bookmark panel, you can change the name of the bookmark  or remove it . 

The other way to remove a bookmark is to right click over the part and click Bookmark again on the 

popup menu to uncheck it. 

Below is the bookmark list containing a bookmark along with a sample part showing a bookmark icon. 
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4.14 Overview  (Professional Edition Feature ) 
The Professional Edition includes an overview tab in the right panel. The Overview is a window that 

shows all parts on the current project page. In addition to the pan and zoom functionality described 

earlier, the overview tab allows for quick pan and zooming anywhere on the project page. 

The overview shows a blue translucent box which shows the part of the project page that is currently 

visible. 

By clicking and holding the center mouse button and moving the mouse, the project page will pan 

according to the position of the blue translucent box. 

The view can be zoomed in by clicking and holding the left mouse button on the overview to pick the top 

left corner of the box you want to zoom to and dragging to the bottom right corner of the view. When 

lifting the left mouse button the project page will zoom to the area shown by the blue box. This gives 

precise control over the view on the project page. 

To go back to the full extents of the page showing all parts in the project, starting with the bottom right 

corner click and hold the left mouse button and drag to the up and left. This will zoom out to a zoom 

factor that will show all parts. 
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5 Adding and arranging parts  

5.1 Adding Parts  
Adding a Part 

On the left panel, click on the part to be added to the project and then click on the 

project page. This will create the selected part in the page at the location where 

the mouse was clicked. 

Alternatively, click the part in the Smart Part tab and while keeping the left mouse 

button down, drag the part from the part box to the location on the project page 

where you want the part to be created and lift the left mouse button to create the 

part. 

When parts are created, depending on the type of part, there may be a popup 

dialog box asking for information to be added, or the part label will be in an edit 

mode ready to be changed. For example, creating a Link part will display a dialog 

requesting either the Internet address for a web page or a file on your computer 

to link the part to. 

 

Default part 

A Default Part is the part type that will be created when the project 

page is double clicked. When MyUniverse is first run, the default 

part available is a Label part. This means double-clicking the project 

page will create a Label part with the label editor box opened. 

Setting the default part appropriately can make it very productive 

in situations, for example, when you need to make a lot of notes 

such as taking minutes in a meeting. By setting the note part as the 

default, it can be very quick to double-click the page, type the first 

minute note, double click to create the next minute note and 

double click again for the next and so on. 

The Default Part can be changed if there is another type of part you expect to use more frequently. To 

change the Default Part, select Application Options from the Options menu. In the Default Part drop 

down list, select which part you would like make as new the Default Part. The next time you double click 

on the project page, it will create that part. 

   

Pasting Part 
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Parts can be created based on what is in the clipboard. Right clicking the project page area will open a 

popup menu that will show a list of parts that can be created based on the type of information currently 

in the clipboard. 

For example, if the clipboard currently contains text having been copied from the some text in a text 

editor, right clicking the project page will offer to create a Label or Note part. Make your selection and 

the part will be created with the label set to the text in the clipboard. In another example, if the 

clipboard contains an image that was copied from a web page, the right click popup menu will offer to 

create an Image part. If you were to copy an MP3 file from the File Explorer, right clicking will open the 

popup menu with choices of either a Media part or Link part. 

Tip: To make creating and placing multiple parts easier, click on the part in the Smart Part tab, then 

press and hold the Control key down. As long as the Control key is held down, each click on the project 

page will create another part. This can make it very fast to create multiple parts of the same type. 

 

5.2 Accessing Parts 
Many parts can access information by displaying particulars in the Details tab in the right panel. A Note 

part will show its text in a text editor as depicted below. A Checklist part will show the checklist in the 

Details tab where the list can be edited. For other parts, accessing may perform a different action. For 

example, a Link part that links to a Microsoft Word document will open Microsoft Word with the 

document when accessed. Accessing a Flowchart part will switch its state. 

Depending on configuration and the availability of a part, the method of access can be set to one of four 

possible settings: 

¶ None ς No access 

¶ Hover ς Access happens as soon as the mouse moves over the 

part 

¶ Single Click ς Access is when the part is clicked once. 

¶ Double Click ς Access is when the part is clicked twice. 

 

5.3 Selecting Parts 
A part is selected when it is clicked with the mouse. The following shows the different selection state: 

 
The part is unselected 

 
The part is selected 

 
The part is the primary selected part which can be resized 

There are several ways to select more than one part: 
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1. Click and hold the left mouse button on the project page background and drag it to make a 

translucent blue square. Any parts that are in contact with or inside the blue square when the 

left mouse button is lifted will be selected. 

2. Hold the Control key down while clicking on several parts. As parts are clicked, they will become 

selected while previously selected parts remain selected. (Note: if a part was already selected 

with the Control key down and clicked again, it will become unselected.) 

3. From the Edit menu, click Select All. This will select all parts on the current page. 

 

5.4 Adjusting Parts  
One parts are created they have numerous properties that can be changed to have the look or 

information you would like to give them. 

Changing a part label 

 

The Label of a part can be changed. There are two ways to put the part label into edit mode: 

1. Select the part, right-click it to show the popup menu and click Edit. 

2. Select the part and press the F2 key. Pressing the F2 key is the quickest way to put the part into 

an edit mode so it is well worth becoming accustomed to it. 

If at any time during label editing, you do not want the changes but want to go back to the original label 

before editing began, press the Escape key. 

Changing properties 

Selecting a part will show a Property bar just below the main panel. The Property bar shows a set of 

buttons for different property categories. Clicking on a property category button will open a pop up 

which you can used to change properties such as the shape of the part, the font, the color and so on. 

Depending on the part, there can be additional property categories specific to the type of part. For 

example, a Link part will also have a Link property category button which contains the link settings. 
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Changing properties on multiple parts 

If more than one part is selected, the Property bar will show only the Property Categories that are 

common between all the parts in the selection. Additionally, within a property bar pop up, if the 

selected parts have different settings for a particular property, that property will be shown in a different 

color and property field will be empty. In the case of a checkbox, it will show as a filled square instead of 

a checkmark or empty. This is to make it clear that for the same property on the different parts, there 

are different settings. 

 

In any case, whether a property setting is the same or not, making a property change will change the 

property on all parts selected. For example, changing the color of the font in the Font pop up panel will 

set the font color for all selected parts. 

 

5.5 Adding Connectors  
Connectors show a visual association between parts. 

Creating a new connector is similar to creating a new part. The difference is that creating a connector is 

not done in a single step but may require two or more steps. 
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To create a connector, select it in the Smart Part tab. Move the mouse over the project page where you 

would like to place the first point of the connector. If it is over a part, a set of magenta squares and a 

circle on the part will be shown. This shows points on a part where the connector point can be attached 

to. 

By clicking on a magenta square, the connector will connect to the part at the point of the square. If the 

part is clicked but not over one of the magenta shapes, it will automatically connect to the point with 

the magenta circle which is the default connection point. 

 

By clicking on the project page and not on a part, the connector end remains a free end. 

Basic Connector 

For a Basic Connector, once the first point is placed, the second point will placed on the next click 

completing the connector. 

Polyline Connector 

When creating a Polyline connector, the first point is placed the same as for a basic connector. Each 

additional click will add another segment until the point connects to a part, or the right mouse button or 

the Escape key is pressed. 

Star Connector 

When creating a Star connector, the first point is placed the same as for a basic connector. However, 

since a star connector can have more than two placement points, each click will add another segment 

until either the right mouse button is clicked or the Escape key is pressed. 

 

5.6 Adjusting Connectors  
Once a connector is created, it can be changed to have the look or information you would like to give it. 

Changing properties 

Connector properties can be adjusted the same way as for parts. When selected, there is a Connector 

property group button where you can change line thickness or show arrows. 

Right clicking on a connector will show a popup menu which, depending on the type of connector, will 

allow you to disconnect it from a part or to insert or delete segments. 
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For more information on adjusting connectors, please refer to the Connector Reference document. 

 

5.7 Moving and Resizing  
Once a part is created, it can be resized and moved. 

To move a part, select it, hold the left mouse down over the part, and move the mouse. When you reach 

the desired location, release the mouse. 

In some parts, such as buttons, it is not possible to select and hold the part to move it. In this case, move 

the mouse until it is just outside the part so that the mouse pointer turns into a Hand. You can then click 

and drag it. 

To resize a part, move the mouse over an edge or corner so the mouse pointer changes to a double 

arrow. Then click and hold the mouse to resize the part. 

For connectors, click and hold the connector to move it. Any connector ends that are connected to parts 

will not move when the connector is moved since they are attached to part. To move a free end, select 

the connector. When selected, any free ends or joints will be shown with blue circle. Click and hold the 

blue circle to move the end or joint to the desired location. Free ends that are moved over a part will 

cause the part to show the magenta connection points which indicate that the connector can be 

attached. 

Note that if a part is Locked, it cannot be moved. Refer to the Common Part reference for how to lock 

and unlock parts. 

Moving multiple selected parts 

When more than one part is selected, all the selected parts can be moved together by holding the 

Control key on the keyboard while moving one of the parts in the selection. This is handy for moving 

several parts together without first grouping them. 

 

5.8 Snap and Alignment  
The Snap page in the Application Options dialog has settings that control snap and snap lines. 
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Snap 

Snap acts as an invisible grid on the page to which corners and edges will snap to when they are moved. 

Generally it is recommended to have Snap turned on to give better control of part positioning. Snap can 

be set to a spacing between 1 and 100 pixels. A snap of 5 means corners and edges will snap to every 

fifth pixel. 

Snap Lines 

Snap Lines are very handy when lining up parts. As parts, edges or corners are moved, if they are on a 

pixel that lines up with edges or corners of other parts, a red snap line will be shown to indicate that the 

edge is in alignment with the edge of another part. 

 

 

5.9 Stack Ordering  
As parts are placed on a page, they are placed in a stack order which means that one part will be stacked 

above another part if they happen to overlap. 

If parts overlap, you can change the stack order by right-clicking a part and selecting either Bring To 

Front or Send To Back. 

 

 

5.10 Grouping  
 

 

Grouping is a handy way to lock parts together so they can move as a group. This can be handy if parts 

have an association with each other so that moving one of the parts in the association will move all the 

parts association. 
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To group parts, select all the parts you would like to group and press the Group button on the Toolbar. 

Once grouped, simply selecting one part will select all the parts in the group. 

To ungroup parts, select the group and click the Ungroup button on the Toolbar 

Note that groups are not Nested. This means that it is not possible to make groups containing groups. 

Tip: There are times when it would be handy if a single part in a group could have its property changed 

or could be moved individually or its size adjusted. The can be done by making sure no parts are 

selected; then, while holding the Shift key down, click one part in the group. It then becomes selected 

instead of the whole group, allowing it to be moved on its own. This same principle can be extended to 

select more than one part in a group by holding the Shift and Control keys down and then picking the 

parts you would like to change. 

 

5.11 File Drop / Store  (Professional Edition Feature)  
 

 

The File Drop/Store section in the bottom right corner of the application window is useful for 

automatically creating a part and storing its contents in the project. In most cases this can also be 

accomplished by creating a Link part, setting the link to a file and checking the Store property. File 

Drop/Store does this in one step. 

The reason for requiring the File Drop/Store feature is because in some cases, it is not possible to store 

information in a link part in any other way. 

For example, if an e-mail in Microsoft Outlook is dragged directly to a MyUniverse project page, it will 

create a Link part as expected but will not actually hold the e-mail. Instead it will contain some basic 

information about the e-mail. To properly create a Link part and store the e-mail, drop the e-mail onto 

the File Drop/Store area. It will create the Link part and will properly store the e-mail in the project file. 

Then when the Link is accessed, the full e-mail will be opened. 

5.12 Part Right -Click Menus 
When right-clicking on a part or a sub-part, a popup menu is shown as below.  

Part popup menu 

Part: ____ ς Indicates the type of part 

Edit ς puts the part label into an edit mode 

Bring To Front ς Brings the part to the front of the stack order 

Send To Back ς Sets the part to the back of the stack order 

Cut ς Copies the part to the clipboard and removes it from the project 

Copy ς Makes a copy of the part in the clipboard 
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Paste ς Paste a new sub-part into the part from the clipboard 

Delete ς Delete the part from the page 

Paste ____ ς Pastes a sub-part based on what is in the clipboard 

Bookmark ς Adds or removes a bookmark 

Set Part Style as Default ς ¢Ƙƛǎ ǇŀǊǘΩǎ Ǉroperties become default for new parts 

Portal ς Create a Portal connection 

Projection ς Create a Projection connection 

 

Sub-Part popup menu 

Part: ____ ς Indicates the type of part 

Cut ς Copies the sub-part to the clipboard and removes it from the project 

Copy ς Makes a copy of the sub-part in the clipboard 

Delete ς Delete the sub-part from the part 

Move Up ς Moves the sub-part up in order in the part 

Move Down ς Moves the sub-part down in order in the part 

Set Part Style as Default ς ¢Ƙƛǎ ǇŀǊǘΩǎ ǇǊƻǇŜǊǘƛŜǎ become default for new parts 

Projection ς Create a Projection connection 
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6 Working with Files  

6.1 Cleaning Files 
Cleaning files means to minimize the size of a project file. Every time a part is deleted from a project, the 

space in the file is still taken so the project can grow in size. Cleaning will clear all unused space to make 

the file as small as possible. 

 

6.2 Publishing Files  
When you want to make your project widely available and share it with others, it should be Published. 

Publishing a project means that in addition to cleaning the file as described above, it makes the project 

view-only and gives it an extension name of .MUPub. Anyone can then download the MyUniverse 

viewer and view the entire project. Note that when a project is published the original .MUPrj remains 

unchanged so you can reopen it and continue working with it. 

People who have MyUniverse Personal or Professional may not have all the parts, meaning any parts not 

available in these editions will not be shown or function properly, so they will need the viewer as well. 

 

A published project will use the same password security as the original project enabling the publishing of 

projects with a password required to open. 

 

6.3 Import/Export Selections  
If you would like to keep one or more parts aside to use in other projects at a later time or to share with 

others, you can export them to an Export file with the .MUSel file extension. 

Select one or more parts on a page that you wish to export and click Export on the File menu. During the 

export, you will be asked if you want to encrypt the export file or not. Choose this option if you have 

sensitive information in the selection. A file dialog will then be opened to allow you to select where to 

put the exported file. If the selection will not be encrypted, the export file will be created right away. If 

you selected Encrypt Export, you will then be prompted for the password to encrypt the export file with. 

You can import a selection by clicking Import from the File menu. A file browser will open to for you to 

locate the file to import. When the file is selected, the imported parts will be placed in the top left 
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corner of the current Project Page. From there, you can drag them to the desired location. If the 

Imported file was encrypted, you will be asked for a password before the parts can be added to the 

project. 

Important: If you forget the password, it will not be possible to import the selection. 



 

Page 26  © 2009 Rhok Solutions Ltd. 
 

26 MyUniverse 

7 Part Properties / Working with Parts  

7.1 Property Painting  

 

The property painter provides a quick way to copy properties, such as shape, font, color, from one part 

to other parts. 

To paint properties from one part to another: 

1. Select the part which has the properties you want to copy from during painting. 

2. Click the Paint toolbar button. 

3. Click on the part you want to change the properties on. 

4. Note: Only certain properties are painted. Generally, the properties painted are the ones that 

do not contain information. Rather, they are ones that affect the formatting of parts. 

To property paint more than one part: 

1. Select the part which has the properties you want to copy from during painting. 

2. Click the Paint toolbar button. 

3. Click and hold the left mouse button down on the background and drag the translucent blue 

selection box. When the mouse button is lifted, all parts that are inside or in contact with the 

box will be property painted 

 

 Alternatively, hold the control key down before clicking on a part. This will keep the property paint 

button down until for the next paint. Holding the control key down while clicking parts will keep the 

property paint button down for the next paint. 

To cancel a property paint operation, unclick the property paint button. 

 

7.2 Cut/Copy/Paste/Delete/Select All  

 

Cut/Copy/Paste/Delete/Select All work as expected in a Windows application. Cut copies the selected 

parts to the clipboard and removes them from the project. Copy copies the selection to the clipboard. 
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Paste pastes the parts in the clipboard to the current page. Delete removes the selected parts from the 

project. Select All selects all the parts in the current page. 

 

7.3 Portals  
Portals provide the capability to connect any two parts in a project together to make it easy to jump 

back and forth between the two parts. 

Portals are created by selecting a part, making it a portal source, then selecting the other part and 

making it the portal destination using the Portal Dialog Window. 

A part can have more than one portal connection with each represented by a separate icon. 

 

To create the portal connection 

1. Right-click the first part and select the Portal from the popup menu. 

2. In the Portal Dialog that is opened, click the check box at the top so it says This part is available 

as a Portal source. 

3. Close the dialog box. 

4. Select the other part to connect to, right click it and select the Portal from the popup menu. 

5. The Pending Sources section in the middle of the dialog will list the parts that are ready to have 

a portal connection made to it. Select the entry that is the first part and press the Connect 

button. 

6. Close the dialog box. 
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Each part will show a Portal icon which can be double-clicked to jump between the two parts. 

To delete a portal connection 

1. Select one of the parts in the Portal connection, right-click it and select the Portal from the 

popup menu 

2. In the Destinations list at the bottom which shows the part this is connected to, select the part 

to disconnect from and press the Disconnect button. 

3. Close the dialog. 

The Portal icon will be removed. 

 

Single click Portal Navigation 

By default, Portal Navigation is done by double clicking the 

Portal icon. This can be changed to be single click by checking 

the Single Click Portal Navigation checkbox on the Portal page 

of the Application Options Dialog box. 

Note that portals can be between any two parts (excluding 

sub-parts) in the entire projectτeven between parts on 

different pages. 

 

 

7.4 Projections  (Professional Edition Feature ) 
MyUniverse also includes a feature called Projections.  Projections allow information associated with a 

Smart Part to be entered and managed in one place but be made visible in multiple places in a project. 

Functionally, one part is designated as a projection source and any number of other parts of the same 

type can be set projection as destinations. 

When a projection is placed, anytime information is changed on the source part, all destination parts 

automatically pick up the changes. Using projections can reduce information redundancy and improve 

consistency of information within a project. For example, in a MyUniverse project that contains an 

organizational chart and a contact list, if an employee has a title change, you must change it in both the 

contact list and in the organizational chart to keep them consistent. By making the contact list part for 

the employee a projection source and the organizational chart part for the employee a projection 

destination, changing the title in the contact list part will automatically have the change shown in the 

organizational chart. Another major benefit of using Projections is to keep the size of project files down. 

For example, if the same image is used in multiple places in a project, the size of the project file is 
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increased because the image is stored multiple times. Using projections means only a single image is 

stored, but is visible in any place and as many times in the project as is needed. Most Smart Parts have a 

projection capability. 

Projections are intended to project information. This means the source part and destination parts can 

have different looks (shape, color, font, etc.) but will show and access the same information. 

Note: Projections only functions between parts of the same type. 

 

To create the projection connection 

Projections are configured in a way that one part acts as a Source and one or more other parts connect 

to it as a Destination. 

1. Right-click the part that will be the projection source and select Projection from the popup 

menu 

2. In the Projection Dialog box that is opened, click the check box at the top so it says This part is 

available as a Projection source. 

3. Close the dialog box. 

4. Select the other part to be the destination, right-click and select Projection from the popup 

menu. 

5. The Pending Sources section of the dialog box will list the parts that are possible projection 

sources and are ready to have a projection destination connect to it. Select the source part you 

would like to connect to and press the Connect button. 

6. Close the dialog box. 
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The destination will show the information from the source part and will start acting much like the source 

part. For, example editing the part label in the projection source part will update what is shown in the 

destination. Editing the label in the destination will update the label in the source. 

To delete a projection connection 

¶ Select one of the parts that has the projection connection, right-click and select the Projection 

from the popup menu 

¶ Depending on whether the selected part is a source or a destination, the connection to be 

disconnected will be listed in either the Source list or the Destination list. Select the part to 

disconnect from and press the Disconnect button. 

¶ Close the dialog box. 

Note that projections can be between any parts of the same type in the entire project including parts on 

different pages. 

 

7.5 Actions  (Professional Edition Feature)  
The Professional Edition of MyUniverse includes the ability to configure Actions. Actions are a way of 

allowing parts to interact with other parts. 

Parts that can interact with other parts have certain Events that occur causing an action to happen on a 

Target part. The following parts have events:  

Action Scheduler When a timer Time as been reached 

Button When the Button is clicked 

Connectors, Label When the connector or Label has been Accessed, when the 
Mouse has moved over a connector or moved off a 
connector 

Flowchart When the state of the flowchart has changed, been set to a 
Yes, set to a No or set to Indeterminate 

Foreign Exchange, Formula, HTML Value, 
Stock Quote, Totalizer, Value 

When the Value has changed 

Google Earth Google Earth has arrived at the destination 

Media Media has finished playing 

Script Script has finished running 

 

The above events can be configured to cause an action to occur on another part. To see what Actions 

can occur on other parts, refer to the Smart Part reference manual. 

Here is an example of how Events and Actions work. Suppose you want a Button part and a Link part 

connected to a web page. To set up the MyUniverse project so that clicking a button will open the web 

page: 
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1. Create a Button part. 

2. Create a Link part and configure the link property to be the Internet address of the web page 

you are interested in. 

   

3. Select the Link part, click on the Information property button and type in a name in the 

Reference Name box. This name will be later used when setting up the Click event in the button. 

 

4. Select the Button part and click on the Action property button to open the Action property 

panel. 

 

5. Click the Add button to add a new Event Action and ensure that the Enabled checkbox is 

checked and the Event is set for Click. 
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6. In the Target list, select the Reference Name for the link part. 

 

7. Select the Action to be performed on the Link part. In this case, it is the Access action. 

 

8. The Action is now set up so when the Button is clicked, the Web Browser will go to the web page 

configured in the Link. 

You can configure any number of Actions for the events for a part. For example, with the Button Click 

event, it is possible to cause multiple actions to occur on multiple parts, by using the same Reference 

Name. 
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8 Working with Project Pages  

8.1 Hierarchy through Pages 
A MyUniverse project is not meant to have everything on a single page. MyUniverse provides a Smart 

Part called a Page which is used to add pages to allow MyUniverse projects to be structured. Pages are 

key to organizing information in a project. 

To add more pages, add a page part, then double click it to open it. Pages in Page parts can contain 

additional Page parts. There are no limits how deep you can put pages inside pages or how many pages 

parts you can have on a page. 

Note that since a page contains a page of parts that could contain additional pages, care should be taken 

when deleting a page since deleting it will mean all the parts and pages contained in it will be deleted 

along with it. 

 

8.2 Navigation Buttons  

 

The toolbar has three navigate buttons. The Back and Forward buttons allow you to go back and forward 

through any view changes that have taken place in the project. The Back button returns to the previous 

view, and the Forward button goes forward in views for any view changes done through the Back button. 

The Up button is a quick way to go up through the project structure if you are in a page. 

 

8.3 Printing  
The page that is currently open can be printed according to the settings in the Page Setup dialog box, 

which is opened when clicking on Page Setup in the File menu. 

Page Setup 

Printers: Select the printer to use 

Page Media: Select the type of media to print to 

Orientation: Print in Portrait or Landscape 

Page Scaling: Scale the print to a certain percentage or a 

certain number of pages 

Flow: Print from the Top/Left of the paper, the Center or the 

Top/Right 

Margin: sets the distance from the edge of the paper to print 

Header/Footer: The Header and Footer Text, Font and Position 
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When setting the Header and Footer text, there are special codes you can use within the text. If you 

want to include the ǇŀƎŜ ƴǳƳōŜǊΣ ŜƴǘŜǊ ǘŜȄǘ ǎǳŎƘ ŀǎ άPage &p of &cέ ǿƘƛŎƘ ƻƴ ǘƘŜ ŦƛǊǎǘ ǇŀƎŜ ƻŦ ŀ ŦƻǳǊ 

ǇŀƎŜ ǇǊƛƴǘ ƻǳǘ ǿƛƭƭ ōŜ άPage 1 of 4έ. 

Code Description 

&f Filename 

&g Full file name (including path) 

&p Current page number 

&c Total number of pages 

&x Current page from the left 

&y Current page from the top 

&d Current Date 

&t Current Time 

&h Current page tab text 

&& tǊƛƴǘǎ ǘƘŜ ΨϧΩ ŎƘŀǊŀŎǘŜǊ 

 

Printing 

 Clicking the Print button prints the current page to the selected printer according to the settings in 

the Page Setup dialog. A standard Windows print dialog is opened for printing. 

Print Preview 

 Because there are a number of settings associated with the print page setup, it is recommended 

that you do a Print Preview to get an idea of how the page will be printed. This will show you what will 

be printed to paper before actually printing the page. 

 

In the print preview dialog, you can: 

¶ Print: Print the page as laid out in the preview. 

¶ Page Setup: Open the Page Setup dialog to adjust settings. When the dialog is closed, the Print 

Preview will be updated with the new page settings. 
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¶ Pages Across: Sets the number of pages across in the preview window. 

¶ Zoom In: Zoom in the preview. 

¶ Zoom Out: Zoom out the preview. 

¶ Close: Close the Print Preview. 

 

8.4 Saving Page Images (Professional Edition Feature)  
The Save Image menu item under the File menu will save the current project page view to a file. 

Clicking on Save Image in the File Menu will open a Save Dialog box. Browse to the location where you 

want to save the file and select the image file type. 

 

8.5 Background Properties  
Each page in a project can have the Background customized. You can change the background to be a 

color, an image or another page. 

 

Coloring 

The background color can be set by clicking the base color and back color buttons. The Base color is a 

color applied to the full page extents. The Back Color is a color for a given rectangle whose dimensions 

are set by the Width/Height/Left/Top boxes near the bottom if the dialog box. This allows you to set a 

colored rectangle with a specific dimension on top of the base color. 

Background Image 

If you would like to use an image as the Background, select the image using the "..." button to the right 

of the image box. An open file dialog box will open allowing you to locate the image file to use as the 

background. Once the file is selected, it can be stored in the project file so that the image will always be 

shown even if the original image file has moved. If you intend to share project files with others, it is 

likely you will want to store the image in the project. To store the image, click the Store Image check box. 
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The Image file's size and location and rotation can be set and the image can be tiled if desired to fill the 

background. 

If the background image is no longer wanted, make sure the Store Image checkbox is unchecked and the 

Image text box is empty. 

Background Page (Professional Edition Feature) 

It is possible to make another page a background page for the current page. This can be useful if you 

would like to make one page the background for other pages to give a consistent look and feel. The 

parts on the background page will be functional but they cannot be edited. 

To set a background page, check the Use Background Page check box and select the page to use as the 

background from the list. Only backgrounds that have been given a name, that are not the current page 

and is not the top level page will be shown in the list. The selected page in the list becomes the 

background. The Replace Background is used to indicate that the background on the current page will 

be replaced with the background of the background page. 

 

8.6 Project Path  
Just above the tabs is a Project Path bar which can help you navigate the structure of a project. This is 

particularly useful if you have pages many levels deep. This will show the name of all the pages from the 

top page down to the current page to help you keep track of where the current page is within the 

project hierarchy. 

 

Note that the names used in the project path come from tag properties of the page parts. For this 

reason, it is very beneficial to set the tags of page parts to something that is easily understood. 

Because the Project Path is made up of a set of buttons, you can click one of the buttons to change the 

view to a page at a higher level within the project path. To get back to the view before the clicking the 

project path button, click the Navigation Back button. 
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9 Working with Projects  
The Options page has some general options used in the project. 

9.1 Project Options: Options  
The Options page has some general options used in the project 

 

Main Page Title: Set the text used in the Main project tab. 

Timer Base Interval: Sets the base timer for the project. Some parts perform functions on a regular 

interval. Parts that used timers for certain activities will be multiples of the Timer Base Setting. For 

example, if the Timer Base Interval is 60 seconds, and a Stock Quote part is set to an Update Rate of 15, 

the Stock Quote will be updated every 15 minutes. 

By altering the Timer Base interval in one place, it will change the interval activities for all parts in the 

project that use the base timer. 

Show Database Options: Database features are an advanced feature. If you will not be connecting to 

databases, leave this unchecked. When unchecked, database property panels will not be available for 

parts. See 10.8 for more information. 

Full Screen Options: For a description of the Full Screen options, refer to the Full Screen section in this 

document. 

 

9.2 Proje ct Options: Properties (Professional Edition Feature)  
The Properties Tab on the Project Options dialog of the Options menu allows you to set Project 

document settings such as Title, Author, Date, etc. 


